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Activation: 

Upon starting COLOR projects 5 for the first time, you will be 

prompted to activate the program. Proceed as follows:  

Install COLOR projects 5 as described by the installation wizard.  

Input your serial number. For the box version, this can be found on 

the accompanying booklet. If you have chosen to download the 

program, you will have received the serial number by email directly 

following your purchase.    

 

Finally, click on the “Activate” button. The software has now been 

successfully activated!  

Note: COLOR projects 5 can be installed on up to two computers 

using the same serial number.   

A second serial number is not necessary. When installing the 

program on a second device, simply enter the serial number again 

and press “Activate”.    
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1. What´s New? 

Color projects 5 offers many new features. Here is an overview of 

some of the most important developments: 

 

 New filter Plug-ins for Adobe® Photoshop (all versions from 

PS CS6 to CC 2015.5).  

 

 With 26 new Presets Color projects 5 has now a total of 160 

presets. On top of that there is a preset browser for all 

presets.  

 

 The interface design has been completely revised and now 

supports work with 4K monitors  

 

 One can now choose the font sizes for menus and titles.  

 

 A hot key list as well as a list of loadable camera RAW 

formats were embedded in the program  

 

 The GPS coordinates of a photo allow you to directly see 

where the photo was shot in Open-Streetmaps.  

 

 There is support for eight extra colour spaces (D65)  

 

The Raw-module has also several new functions: 

 

 

Category “FX“ with 8 extra effects  

Light diffraction correction in the area of colours  

dynamic brightness 

Trapez distortion  

Colour dynamic 
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 New: comparison of function in preset browser 

 

 What´s really practical: the optimisation assistant with 

different choices of opacity  

 

 The absolutely novelty in Color: film grain-module with 

adjustable ISO number, six different film grain forms, 

masking the film grain and fractal film grain.  

 

 Many new effects and functions you can find in the 

selective drawing module 

 

 

Increasing contrast 

Reducing contrast 

Blending in the original image 

Mask production in optional brightness/ colour 

Smoothing Brush 

Soft focus effect, reduction, increase on masks 

optional mask colour 

automatic adaption of masks from selective drawings onto 

the distortioncorrection in RAW - module  

 

 

 Composing modus with free downloadable pictures in four 

levels in the selective drawing module  

 

 New photographic film emulations  

 

 Color projects 5 has now 18 new post-processing effects 

(145 now in total):  
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Dissolving Optimisation of the 

structure 

Mist & Fog reduction Logarithmic gradation of the 

colour channel 

Denoising optimisation Colour correction 

Colour dynamic Abstract painting 

Film grain - Analogue Kaleidoscope 

Film grain - Fractal Light drawing 

Logarithmic gradation Ornament 

Optimising the focus Brush marks 

Restoring the highlights Water reflection 

 

 

 

 Extra: 56 course pre-settings for the selective processing 

all post-processing effects  

 

 Imagetapering with 71 style sheets and new tools to help 

like the golden spiral, the golden cut and the third rule over 

helplines  

 

 Optimisation of the post-processing engine.  

 Two fold speed increase and more  
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2. Photos Done Quickly 

 

You can obtain a finished image in just 4 clicks with Color projects 5.  

1. Load Images  

2. Post-Processing Preset Selection  

3. Optimisation Assistant  

4. Select Image Detail and Save  

 
You can simply drag and drop your images or bracketing series 

onto the start screen 

  

How to get the results you want, and fast - the elaborated presets 

and looks, individual image adaption and selected drawing allow you 

to also go the creative route. Color projects 5 offers both options. 
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3. Configuring the User-Interface 

 

Optional font size for Menus and titles  

In the main menu of the program you will find in View -> font size an 

option to customise the size of the letters in the menu as well as in 

the titles of the program.  

 

The font size can be adjusted to the run time of the program. 4K – 

monitors gives you the option to enlarge the font size for better 

readability of the menu. 
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4. Importing Image Material 

 

To load an image, simply drag and drop the images onto the start 

screen. Alternatively, you can also use the toolbar buttons or 

dropdown file menu.  

 

 
 

As soon as you have chosen a photograph and dragged and dropped 

it onto the start screen, the dialogue and image preparation will 

appear. 
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5. Optional: Image preperation 

 

Click on Extras/Preparing image… . Here you can precisely 

configure the image 

preparation settings or 

select the standard 

settings and turn off the 

image preparation 

window which pops up 

upon uploading photos.  

 

For the first steps, select 

the standard settings. 

Clicking the back arrow at 

the bottom left restores 

any changes made here 

back to the standard 

settings, so nothing is 

irreversible.    
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a. Colour space 

conversion: advanced 

users can choose a 

colour space here - for 

all other users, it is 

recommended to not 

make any adjustments, 

to avoid incorrect colour 

rendering later.  Color 

projects 5 offers several 

new colour spaces (D65). 

Standard illumination 

D65 is representative for 

a phase of natural 

daylight with the colour 

temperature 6500° Kelvin. 

 

b. White balance: corrects colour casts that occur with shots 

taken, for example, in a warmly lit room. To start, leave this 

setting unchanged. 

 

c. The colour temperature ranges from 1000K to 16500K, 

which makes for a powerful tool for establishing warm and 

cool moods.    

 

d. The backwards arrow returns all adjustments back to their 

initial values.   

 

e. The checkbox at the bottom edge of the window allows you 

to choose if you would like to have this window displayed 

when uploading images or not.  
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f. RAW-options: The automatic brilliance optimisation for 

RAW files can be activated in image preparation under RAW 

options. Frequently it is with camera RAW formats that the 

image data will not use all tonal values that are available. 

The automatic brilliance optimisation compensates this with 

the uploaded RAW images by amplifying the tonal values so 

that a meaningful utilised histogram is created for every 

camera RAW image. 

  

 

g. This arrow exits the image preparation and takes you to 

post-processing.   
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6. Post-Processing: Presets  

 

We are starting directly with 

post-processing after uploading 

the images. Here we can control 

the picture’s tone mapping and 

edit the results with filters and 

effects.  

 Left side of the post-

processing screen: the presets 

show the breakdown of the live 

preview in categories - “All”, 

“Natural”, “Landscape”, 

“Portrait”, “Drawings”, “Custom”, 

“Surreal”, “Architecture”, 

“Artistic”, and "Seasons" with the 

quantity of presets in the 

appropriate category   

To begin, we’ve chosen the 

“Natural high quality” preset. 

Clicking on the preview image 

applies the effect to the image in 

real time, which will then be 

displayed in the middle of the 

screen.  
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Discover the wide variety of different looks by clicking on the 160 

different presets. You will be amazed by the intriguing styles in the 

artistic section! 

 

Image with “Landscape powerful” preset. 

 

Image after applying the “Portrait Smoky” preset. 
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All 160 COLOR projects 5 

presets at a single glance. 

The “Presets” section can be 

separated from the rest of 

the interface by clicking on 

the "Default settings" bar, 

which then allows you to 

adjust the size of the 

window as you like.    

 

 Preview Gallery  

Would you like to see all the previews for the loaded image or series? 

Click on the “All” category and then on the symbol.  

COLOR projects 5 creates then a browser gallery with all the 

presets. For a bigger display click on the image. 
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This very practical feature is reminiscent of good old contact sheets. 

You can create proofs to assess how the image with your favourite 

presets would look when printed.    

 

 The Preset browser  

 

The variation browser allows you to choose from different versions 

of a function and is primarily operated with the mouse:  

 

 shifting the segment: hold down the left mouse button, 

before moving the mouse  

 zooming in: scroll up  

 zooming out: scroll down  

 choosing the variant: double left click on the image  

 setting a referent: left click on the image  

 comparison with referent: hold down the right mouse 

button over the image  

 

The corresponding short cuts you can find under “menu 

information -> keyboard shortcuts” 
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Click on the symbol and Color projects 5 will show you 

the entire preview gallery of that chosen category. Zoom in 

now on the variant that you want to compare and set a 

reference image. 

 

 
 

This reference image you will be able to put on any image through a 

left click of the mouse. You can fade in this reference image into the 

other image by holding down the right mouse button.  

The border surrounding the image in a green dashed line shows you 

the reference image so that you can make the comparison.  

In this way you can compare any two variants in the browser directly 

and visually.  

 

Example: As a reference image you choose the variant “natural lively 

colors” and mark the image with a left mouse click. The green 

dashed line shows that you have chosen this image. 

Now you look for a different preview image, in this case Preset 

“artistically vintage” has been chosen.  
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Here you can see the preset “artistic vintage” and “Duotone 

Rosé” in a direct comparison. 
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Right click on the preset “artistic vintage” and the reference preset 

will fade in. As soon as you let go of the mouse button, you will see 

the “naturally contrast” preset again. This is how you simply and 

purposefully compare looks with another before choosing the ones 

you like the best.  

 

Selection of your desired variation:  

With a double click you chose the variant. The relevant program 

settings will be carried out automatically.  

 

Tip:  

Your current choice will be automatically set as your reference 

image, when you open the window. 

 

 

 Combine presets  

To merge two looks together use the “Combine default presets" 

button directly under the categories. These new presets will be 

saved under "Custom". It’s that easy to expand your numerous 

options and accumulate new ideas!  

 

 Name Favourites  

 

Have you found certain presets 

that you love and instantly want 

to have handy?  
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Click on the top right star in the 

preset window and add the 

setting to your favourites. By 

clicking the button, previews all 

of your favourite presets will be 

displayed.   

 

 

 Comparison View   

Do you want a comparison to the image without tone mapping? 

Simply right click on the middle of the image to see the before/after 

result. A quick check on the editing process is available at any time. 

For an extensive overview with selectable areas and luminance 

display, click on the symbol bar.    
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 Preview Mode    

When this option is activated, the result image will appear as a small 

preview size. If this option is deactivated, the picture will appear in 

its true size. Please note that processing the preview can take longer 

when this feature is deactivated. 

 

 Real Time Processing    

When activated, all of the changes that you have made to the preset 

settings will be immediately applied to the image and you will see 

the outcome of your adjustments directly. If this option is 

deactivated then the changes will only be shown, when you click on 

the “calculate anew” button.  

 

 High-Quality Display   

Activate this option to see the preview image in high-resolution. If 

the preview is set at 100%, there will be no difference. If you zoom in 

on a section of the photo however, there is a noticeable difference in 

quality.   

 

 “Original resolution“ symbol  

With this button you set the zoom factor back to its original 

resolution.  

 

 “Setting the zoom factor to screen size”  

With this symbol you set the zoom factor to the maximum possible 

screen size.    
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 Border Pixel Display   

The border pixel display helps to reveal areas that tend towards 

maximal light and dark values, hence those that are to white and 

black. Dark border pixels are depicted by blue and light pixels by 

orange.   

 

Depiction of border pixels in dark blue and orange tones   

If you would want to brighten this image, you have to be careful of 

the orange border pixels. Light surfaces in the sky and on the water 

should not become too white, in order to avoid losing detail. In 

technical terms, these patches are called “burned highlights”. The 

border pixel view helps to find these critical image areas.   
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 Import/Export of Presets  

 

Presets from earlier versions can be easily imported. Do you want to 

exchange all of your presets with a friend or just secure all of your 

treasures? Use the practical export function. 

 

 Filter Presets 

Locating presets can be difficult when you have imported presets or 

created many additional looks. For example, enter “glow" into the 

search bar and only presets relating to “glow” will be shown. 
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7. Post-Processing: Finalise   

 
Now that we have understood the most important part of post-

processing, let’s go onto fine-tuning, which can be found on the right 

side of the screen under “Finalise". These features are intended to 

only to be used to edit pictures further after selecting a preset.  

 

 The magnifying glass  

 

On the right hand side (at the very top) in Post-processing you will 

find the 1:1 magnifying glass. The magnifying glass shows you the 

area under the mouse in a 1:1 pixel view.  
 

 
 

To keep the magnifying glass on a specific point, press down on the 

“L“ key, while you move the mouse over the screen.  
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Click into the image area of the magnifying glass, to change between 

the display modus “divided before/after comparison” and “direct 

before/after comparison”.  

To free the fixated area of the magnifying glass, press down on the 

“L” key once more. 

 

 Point of Interest  

Activated “Point of Interest” renders the current editing only to a 

specially defined area of the image. The effects will be applied in 

their full form, however only visible in the specified spots, the rest of 

the image will be left unaffected. This effect is intended for very 

large, high-resolution photos, for example panorama pictures. 

 

 Intelligent Colour Space (SCA Processing)   

This menu offers you options for 

optimal colour detail gradation of 

your tone mapping results. Selecting 

SCA processing (Smart Colourspace Adaptation) demonstrates 

differences in the details of more saturated colours.   

Tip: With “Supersampling” you will get exceptional details and 

saturated colours 
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 Film emulation and 

preview browser 
COLOR projects 5 has come up with a 

photo film emulation engine that 

projects film-looks of the legendary 

days of analogue film onto your digital 

photos.  

In this version you will find 10 new 

fantastic photo film emulations: 

 

 

 

 

Fuji Velvia 50 Kodak Professional Ektar 100 

FUJI Fujicolor C100 Kodak 100 Extra Colour 

FUJI Fujicolor C200 ROLLEI CHROME CR 200 

AGFAPHOTO Vista Plus 200 ROLLEI Crossbird 

AGFAPHOTO Vista Plus 400 ROLLEI Nightbird 

 

Rummage through a box of old photos – it´s worth it!  

Select a type of film and its specific colour characteristics as well as 

the grain and contrast film effects, to apply to your picture  

Since the grain of a photo is a very specific characteristic, one is able 

to adapt the strength of the grain via a controller. You can regulate 

the intensity of individual features as well as the overall effect of a 

film look. 
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 Optimisation Assistant 
 

 

The optimisation assistant is a 

very efficient tool for fast, 

fascinating results. When the 

preset is activated, denoising, 

tonal value, clarity, dynamic 

and sharpness settings can 

all be adjusted by sliding the 

control to the left or right. The 

result can be seen live. The 

optimisation assistant is 

intelligent; it remembers the 

values you entered, and 

applies the same settings to 

the next image in the same 

way, but tuning the result to 

the new motif. 

If you would like to edit without the assistant, you can simply turn it 

off. If you would like to turn off the values that have been “learned” 

so far, click on the  

Additionally, the assistant can be 

given optimising specifications for 

an entire image style: choose 

between natural, brilliant, fine, soft, 

intense, sober colours, high key and 

low key   
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 The opacity regulator of the optimisation assistant 

The opacity regulator in the optimisation assistant activates itself 

automatically as soon as one optimisation is activated. The opacity 

regulator works on every effect 

that optimises the image as 

well as the optimising pre-

settings.  

Pro Tip: Remember that the preset specifications and Optimisation 

Assistant are added together. If you select the “landscape powerful" 

preset and the “Intense” optimisation, you will get strong, saturated 

colours and dramatic contrast. Not to worry, you can quickly change 

back to the “Natural” optimisation and have the familiar look of the 

“landscape powerful" again. On the other hand, you can compile 

new creative ideas and jump between intense, unsaturated and high 

and low key looks lightning fast. 
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 Granulation module  

 

a) Natural grain  

 

In natural grain the different 

levels of photographic paper are 

simulated, which creates a 

natural irregularity.  

 

These following parameters are 

therefore at your disposal:  

 

- Form  

Choose here from six different 

variants. 

 

- ISO-number  

The preset value conforms to the average “restless value” on a 

naturally grey surface. 

  

- Size.  

The maximum size of a simulated grain.  
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- Masking  

Gives you the opportunity to calculate the granulation in all different 

types of daylight or alternatively in light, shade or shade and light.  

 

 
Here the Masking has only been set for the lights. This way they 

receive a natural granulation, while at the same time the sky is 

spared.  

 

 A Click on the button creates a new random distribution of 

grain and therefore a whole new look. 
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b) Fractal grain  

 Fractal grain simulates a large 

scale irregularity, which is 

created through the storing and 

deterioration of photo material. 

Therefor the following 

parameters are at your disposal:  

 

 

 

- ISO-number  

The preset value conforms to the average “restless value” of a 

naturally grey surface.  

 

- Quality  

Determines the accuracy of the calculation (number of iterations for 

the fractal algorithm) of the fractal granulation. In the granulation 

module there is no singular best setting, since the ideal grain size, 

form and quality is 100% dependant on the motif. Here you can try 

out different things and find new creative paths.  

 

 A Click on the button creates a new random distribution of 

grain and therefore a whole new look. 

 

 Scratch and Sensor Errors  

 
Micro-contrast enhancement used in photography unfortunately 

shows every unwanted sensor imperfection that every 

photographer, despite internal camera sensor cleaning, knows and 

dreads. Don’t stress - just eliminate them! With the easy to apply 

correction function from COLOR projects 5, it can even be fun.   
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Pro Tip: This intelligent correction doesn’t only remove sensor spots, 

but other disturbing things too - a deserted beach has never been so 

easy to produce. Lightly mark defects in your motif, the program will 

automatically substitute these areas with other appropriate parts of 

the image. 

 

 
Circled in red are the sensor spots in the original photograph.   
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Here’s how to go about correcting:  

Select the brush tool under (6) and click 

on the point of the image that you would 

like to correct. A circle will appear beside 

it that will serve as a source. Move this 

circle to a place on the image that can 

act as a source for the first marking. The 

selected area will then be improved 

based on the source.  

Prior to this, you can reveal sensor 

spots, which will appear as a bright 

patch in the image, with (1).  

(2) allows you to expose or hide the 

fixed areas. Even when the corrections 

are still active, even if they have been 

blended in. Hiding is solely to enable a 

before and after comparison.  

You can select multiple areas to correct 

by simply clicking on the brush symbol (6) and adding another point. 

The button marked (3) can blend the targeted corrections in and out, 

which also controls clarity.  

(5) deletes the added corrections.  

The section marked (7) controls the size of the area that is to be 

corrected.  

You also have the option to automatically search for the best source 

area for the improvement. Click on the (8) button.  

Button (4) calculates the appropriate correction spots for all of the 

points automatically set using (8).  

All currently selected corrections can be deleted with the (9) button 
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The sensor spot corrector marks all of the patches and 

determines a source within the image that can be used as a 

substitute. 

 

 
The sensor spot corrector was successful.  
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 Post-processing Expert Mode  

 

The Post-Processing expert mode 

can be found on the right side of 

the screen. Here you can 

configure all post-processing, try 

new effects, adjust a selected 

preset or construct a completely 

new preset to meet your desires.  

 

Overview of the Tools:  

a) Display Finalisation 

Assistant as active/not 

active  

b) Display natural grain 

active or reset 

c) Post-Processing Effects 

(total 145)  

d) Selected Effects (made 

up of the preset and your 

chosen post-processing 

effects) 

e) Settings for Selected 

Effects 
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       a) Display Finalisation Assistant  

 

It’s worth it to take a moment to see if the changes were made 

to the settings for the film engine or the optimisation assistant. 

This way you can check for any unwanted doubled effects. 

b) Display natural grain 

Here you have the opportunity to see whether grain was added 

and whether you want to reset the adjustments you have made 

or not.  

c) Post-Processing Effects (145)  

 

The list includes 145 different 

post-processing effects that 

can be freely applied and 

combined. The effects are 

divided into six categories, 

each with a corresponding 

background colour.  

 

Yellow: border effects  

Green: geometric effects  

Turquoise: exposure effects  

Blue: colour effects  

Purple: diffusing effects  

Pink: artistic effects  

 

Tip: If you are looking for a certain effect and know its name or part 

thereof, you can save time by using the search bar.  
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When you are applying new post-processing effects, check to see if 

the optimising assistant is active. If it is, please remember that 

effects will act differently, and sometimes more extreme. When 

constructing or enhancing a preset, it is best to turn it off. (Button 

above post processing). 
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d) Select Effects 

Have you found an effect that you would like to try out? Simply 

double click on it in the post-processing effect list. The effect will now 

be shown in the block below called “Effects you have selected". The 

block of selected effects is the heart of the post-processing area. It 

includes all of the post-processing effects and the settings for each 

individual effect.  

The filters in the example are automatically applied one after the 

other to the image and lead to the edited result image.  

 

- To temporarily deactivate an 

effect, simply click on the box 

beside the effect’s name and 

remove the checkmark.  

 

- Double clicking on an effect 

removes it from the list.  

 

- Effects can be sorted at will by 

dragging and dropping them up 

or down the list.   

Tip:  

The order of the effects within the list can have a substantial effect 

on the resulting image. It’s worth playing with!  

Activate the 360° panorama mode in the bottom left box to prepare 

your images for a perfect panorama stitching. The images will be 

optimised, so that no borders can be seen when the panorama is 

assembled. 

- The context menu for the effects you have selected has numerous 

functions that allow you to activate, deactivate, move or duplicated 

effects. 
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e) Settings for Selected Effects  

Settings for the selected effects can be found directly below the 

block for the effects you have selected. The parameters for the 

currently selected effects will always be shown here. The available 

settings and options change depending on the effect you click on. 

There are sliders, gradation and mask curves, colours and pipettes 

etc. Alternatively, a numerical value can be entered into the box 

above the slider.  

The example shows the parameters for the “colour balance” effect, 

which consist of slide controls for cyan red, magenta green and 

yellow-blue. Moving the rulers adjusts creates changes that will be 

immediately displayed in your final image. The ruler’s overflow in 

colour gives you a direct indication of how the new value will affect 

your image.  

 

 
 

The adjustment of cyan red and yellow-blue values allow for a 

clearly warmer colour reproduction of the image. 

 

 Example Mask Curves  

This curve regulates the intensity of the 

effect for particular bright areas of the 

image. When you pull a point downwards, 

pixels with this brightness will be impacted 

less by this specific effect, and vice versa.  
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Here you will find in the top right hand-side a box with several 

different pre-settings. In this example the pre-setting “bright lights” 

has been chosen.  

For the gradation curve in this example, it means that the lights in 

the picture will be brightened, and the dark areas will exempted in 

order to create a striking contrast. This is how mask curves give you 

the opportunity to selectively influence images. During the editing, 

the preview behind the mask curve immediately shows the effect’s 

intensity from black (no effect) to white (full effect). 

 Layer Processing Methods  

These features determine the way that an 

applied effect appears on a layer. Effects 

can thus be enhanced or reduced, and 

looks can even be completely changed, 

which opens up a plethora of 

opportunities to play with. To apply 

processing methods, click on the drop 

down menu beginning with “Normal”. 
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The application of different layer processing methods on a 

single effect leads to completely different results.  

 

So that you don’t have to try out every single effect, we have a layer 

mode browser.  With just one click, you have an overview of all of 

the processing methods and can comfortably choose which method 

fits the effect best. Give it a try! The effects that you can generate 

with layer processing methods are astounding 

 Selective Editing  

For every single one of the 127 post-processing effects it is possible 

to apply the selected effect to only a certain area. Furthermore, 

specified areas of an image can be influenced at different intensities 

by different effects. The selective editing can be controlled in the 

parameter area of each effect and you can open the accompanying 

window with the button at the far left.  

At the bottom of this window there are three blocks with six, three 

and two buttons.  
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This example precisely shows the “colour intensity” effect 

applied to only the selected area. Since 93% rounding has been 

selected, the section is almost rectangular. 

 

6 Block: add, remove, duplicate, flip and delete the selected areas  

3 Block: various display modes for the resulting intensity of the 

effect  

2 Block: choice of selected surfaces, very practical if the specified 

areas are very small or overlapping. 

 

You can add up to 32 amplifying (positive) or reducing (negative) 

areas for the current effect. The size and position can be determined 

directly in the image, optionally in the corners or on the sides of the 

area.  

The roundness of the rectangle as well as the sharpness and severity 

of the selected area can be adjusted with the three controls at the 

top of the window. The result will always be instantly displayed upon 

releasing the mouse button. 
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 Selective editing – gradient module  

You can choose from every post-processing effect in the area of 

selective editing a course (gradient) of 56 premade models with a 

single click.  

To activate the desired post-processing effect from your chosen 

effects, click in the underlying parameter area on the gradient- 

slider.  

 
A window will open with different types of gradients. From there 

choose with a left click your desired type of gradient. 

Tip: When you choose a gradient model then the selected areas (that 

may be already available in the currently chosen effects) will be 

copied onto clipboard. You will be able to transfer it back again by 

using the controller. 
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 Overview of Certain Keyboard Shortcuts:  

Cursor Buttons: move the current, active, selected area  

Ctrl/Alt + Cursor: fast movement of the current, active, selected 

area  

1,2,3: switch the display mode 

Delete: deletes the current, active, selected area  

Esc: closes the window  

 

Upon closing the window, the chosen effect will only be applied to 

the selected area and displayed in the middle of the screen.  

 

You can transfer other effects to the selected area 

with the “Copy” and “Paste” buttons, without having 

to retrace the selection again.  

 

This button deletes all selected areas of the active filter, of 

course with a confirmation prompt first. 

 Custom Presets  

One thing is certain, regardless of which settings you have changed, 

if you have applied additional filters or adjusted a filter’s settings, the 

selected preset has been modified and to the right of the preview 

image is the following symbol: 

 
 

Clicking will reset the preset back 

to its initial state. Careful: All of 

the modifications applied up to 

this point will be undone!  
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Clicking  saves all of the changes in a new preset. A dialog box will 

open where you can enter a new name for your preset or confirm 

the suggested one. The system will name it “Copy”.  

 

The preset will be saved and moved to 

the “Custom" presets category.  

 

The new preset has been additionally 

generated and the starting preset is 

preserved.  

You can also never overwrite a default preset!  

Let’s switch now to the “Custom" preset category.  

 

Here we can find our first custom preset.  

There are a few new symbols to the right of the preview image:  

 

 Is this the favourite preset that 

you have made? Mark it to find it 

right away next time!  
 

 Have you changed this preset 

and don’t want to lose this new 

look? Then create a new one!  

 

 Reset the most recently 

changed settings for the newest 

preset  

 

 You have readjusted once 

again? No problem. Save the 

changes with the disk symbol  

 

 Change the preset’s name  
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 You can also delete your custom preset entirely 

 

 Use this to enter a search 

filter. For example, enter the 

search filter “Colour play”, 

subsequently type the term 

into the search filter bar 

directly under “Import". All 

presets with this search filter 

will be displayed. You can enter the names of places you’ve 

holidayed and all of the presets that you used for those specific 

holiday photos will then be easy to find and to apply to other 

pictures.  

The filter drop down menu to the right already contains “Colour 

play" and you can simply select it from the entered search filters 
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8. Local Adjustments and Selective Drawings  

The new highlight tool from COLOR projects 5 deserves very special 

attention. Firstly, this tool selectively edits chosen areas without 

complicated masks done by hand, like other photo editing programs. 

COLOR projects 5 includes a completely newly developed intelligent 

border recognition algorithm that independently identifies borders, 

lines, differentiations and light differences in drawing mode. The 

boundaries of the area that the mouse skimmed over are saved as a 

mask. These easily and precisely set masks serve as the basis for 8 

important image enhancements: “Shading", “Illuminating”, “Back to 

previous colour”, “Intensifying colour”, “Reduce colour”, “Strengthen 

details”, “Reduce details” and “Sharpen”. A mask can even be saved 

as its own image file and used in other photo editing programs.  

 

 
 

It’s easiest to see how the whole thing works through an example 

image. First, let’s open the selective drawing window (post-

processing/finalise - bottom right). As example image a single RAW 

file of a typical flower motif will be used. In this case we want to have 

the flower petals a lighter shade so that you can differentiate them 

more easily from the dark leaves.  
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1) Select editing objective  

For this case, select “Illuminating”. Make sure that the selected  

mask function is activated and the green checkmark is showing. 

  

 
 

2) Activate drawing mode  

 

3) Activate filling mode  

 

4) Run the mouse over the contours without clicking. You can 

decide and correct the brush size afterwards 
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5) Now look at the mask display. The object where the borders 

were automatically recognised is now depicted. Click and 

hold, and then trace your mouse along the edges of your 

chosen object until it is completely selected. In the blink of 

an eye we will see the effect as well as the overlying mask.  

 

 

 

6) Once fully selected, blend the mask out by moving the mask 

intensity control to the left. 
 

 
 

7) Now you only see the effect, that is, the brighter clouds - our 

objective was “Illuminating”. Now you can adjust the 

intensity of the effect by sliding the control towards the + or 

-, according to your preferred strength.  

 

8) Done! The selected areas have been brightened, while rest 

of the image has not been touched  
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9) Click on “Close”. You will be returned to post-processing and 

the selective change will be applied.  

 

 
On the right you can clearly see brighter clouds that have been 

through the selective procedure. The foreground and the ocean 

continue to have the same tonal values as previously. 

 

10)  Use your quickly made mask for a further effect. Go back to 

the selective drawing. Our selective mask has remained.  

Click on  and copy the mask to the clipboard. Switch the 

mask to “Sharpen” and use the   to paste the mask back 

again. Now you have sharpened just the rocks, and the 

other parts of the image were not influenced.  

11)  Every selectively applied effect can be activated and 

deactivated with the green checkmarks.  

12) Borders have different intensities in every image. Presets 

normally do just fine, but sometimes it is necessary to 

adjust the contour and sharpness settings in order to reach 

perfect fine-tuned results.  



COLOR projects 5 – user manual 

51 

 

 
 

13) Have you drawn outside of the lines, despite the border 

recognition? You can easily remove it with the eraser  . If 

you only want to remove a small section, use the eraser 

with limitation. When set to 50%, you can only remove 50% 

of the mask, regardless of how much you erase. The limited 

drawing mode works in the same way, and only draws at a 

certain opacity.  

14)  If you want to mask the entire image except for a small 

object, it is a good idea to mask only the small object and 

then reverse the mask by clicking on the .  

 

Pro Tip: You have two filling modes to choose from when you want 

to fill a mask. When do you use which mask? We used the normal fill 

mode   as in our example for a 

large surface, which is also preferred 

for water and sky areas. 

Ray filling mode  is very precise and 

favoured for smaller objects, geometric 

forms or subjects with straight lines, 

like in our example here.   



COLOR projects 5 – user manual 

52 

 

 

With the ray filling mode you will be able to mask chairs 

perfectly, while the sky and ground areas remain untouched. 

 

New in COLOR projects 5:  

 

 Optional mask colours  

Choose for the presentation of the mask as well as the brush one of 

the ready-made colours.  
 

 
 

The display will be immediately adjusted to your desired colour.  
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 Selective Drawing – Creating Masks  

Masks can also be created from a colour or brightness. 
 

 
 

With the button (1) you activate the “Create Mask” modus. You will 

find yourself in the standard mode “Create Mask out of Colour”(2). If 

you want to create the mask out of a brightness, chose the (3) 

button.  

 

The tolerance controller decides, how sharp (smaller value) or soft 

(higher value) the created mask will be.  

While you are in the “create mask” mode your mouse pointer will 

turn into a pipette. The colour or brightness in which your mouse 

pointer is set, will determine the type of mask being created.  

 

 
In the above example we can see how a red mask has been created 

for the sky  
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Tip:  

If you want to combine several colours in one mask, simply click on 

the desired colours after each other with the pipette on the screen. 

The current colour will with every click be added to the current mask.  

 

 

 Selective Drawing – Smoothing Brush  

The smoothing brush (1) gives you the opportunity to draw selective 

areas of the mask softly.  
 

 
 

To draw an area even softer, just go over the same area with the 

smoothing brush several times. 

 

 Global Mask Functions  

In the area of global mask functions are several special modes that 

one can use directly.  
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1. Reducing the entire mask outline  

 becomes  

 

2. Increasing the entire mask outline  

 becomes  

 

3. Soft-focus effect on the entire mask  

 becomes  

 

With global functions there are two buttons – the left button fulfils 

the function with a lower effect while the one on the right with a 

bigger effect. 
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 Adaptation of automatic masks onto the 

“Distortioncorrection” of the RAW module  

Selective drawing works directly with the RAW module. This includes 

the “Distortioncorrection” that is part of the RAW module and that is 

applied completely automatically on several drawn masks.  

In the example we have an image, where the sky has already been 

masked.  

 

When we now subsequently correct in the RAW module the horizon 

within the image, then the drawn mask will automatically adjust itself 

to the “Distortioncorrection”. 
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 To reset the function of a mask  

Every mask can without any influence on the other masks be reset to 

its original state. You simply click on the waste paper basket button 

(1).  

 
 

After clicking on the button a security query will follow, so that no 

important work can be lost by accident.  
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9. Composing-Modus 

In the Composing modus of selective 

drawing you have the opportunity to 

build up to 4 levels of images into 

your current motif.  

 

To switch into the composing modus, 

click on the “composing” button (1).  

 

From the list of choices (2) you can 

choose with which composing level 

you want to work with.  

 

With the button (3) you activate the 

currently chosen mask.  

 

Now you can through a click on the 

frame of the image (4) upload any 

image you wish  

to create the next level.  

You can use RAW images, Jpg, Tiff as 

well as several other image formats. 

 

 

 

 

 

Underneath the display screen you will find the parameter area that 

begins with two buttons with the following functions:  

 

(5) Multiple application  

Reduce the size of the image on a different level than the one that 

you´re currently working on. With this option you will be able to 

stretch the reduced image outwards (up, down, left, right).  
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(6) Determine the width-to-height ratio  

This function allows you to determine the width-to-height ratio of 

the uploaded levels, since the width-to-height ratio in an uploaded 

image level can differentiate from the current image you´re working 

on. This preserves the proportion of the levels.  

 

(7) The Control-parameter  

Width-to-height ratio: If the width-to-height ratio isn´t fixed with 

the button (6), you will be able to change the width-to-height ratio 

however you desire.  

 

Zoom: Choose the size of that image level by zooming in or out  

Shifting horizontally: Move the image level to the left or right  

Shifting vertically: Move the image of that level up or down.  

Exposure to light: Regularly the light from your current image does 

not match with the exposure of your other image levels. Here you 

can adapt the exposure and darken or brighten the images however 

you want, so that they match. 
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A not very exciting photograph of the night sky….. 

 

 
....can with the help of the composing mode be transformed into 

an eye catcher in less than a minute. 
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10. Workflow 

 
 Edit final image further in an external program  

COLOR projects 5 offers interaction with external programs. That 

way you can take a successful image result to another photo editing 

program and continue there.  

 

 

 Open in other projects programs  

 

Click on the “Projects” symbol in the toolbar to open the image in a 

different program from the projects series. Use the drop-down 

menu beside the symbol to choose 

one of the programs that you 

already have installed on your 

computer.  

 

 Open in other photo-editing programs  

 

To directly open the image in 

another photo editing program, 

such as Adobe Photoshop, click 

on the corresponding button in 

the symbol bar.  
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If necessary, go through the 

settings to show the path to the 

program. Click on “Extras” in 

the menu and select “Settings” 

in the drop-down menu:  

Next, click on the “Export” tab. 

You can enter the name of a 

photo editing program here, 

and save it for later as well. 

 

 

 

 Work with a timeline and restore points  

This option can be found in the symbol bar at the top edge of the 

screen:  

 
“Create Restore Point” saves an in-between point of the current 

settings. You can now always return to this stage of your editing. You 

can save as many editing restore points as you like. The timeline 

displays the restore points and makes it possible to call up any 

phase with just a single click:  
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This function is especially useful when, for example, you are satisfied 

with an image, yet want to continue trying out different settings and 

effects. Simply set a restore point and carry on editing your picture. 

If you want to go back, simply click on your restore symbol in the 

timeline. 
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11. Selecting and Saving Sections of Images 

 
To save a final image, click on the button in the toolbar, go through 

the file menu or use the corresponding keyboard shortcut (Ctrl+S).  

 

 Cropping and captions  

As soon as you have initiated to save a file, the cropping and caption 

window will open.  
 

 
 

At the top are several practical aids for perfect image composition 

and cropping.  

You can set the aspect ratio and activate guidelines like the rule of 

thirds, the golden section or the golden spiral. Practical is also the 

new photo centre display that you can obtain by simply clicking on 

this button.  
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The centre of the window shows your final image. Fix the area to be 

saved by adjusting the corners and borders of the photo.  

At the bottom is an option to enter a caption. You can determine the 

size, position and background for the text. The size of the text will be 

automatically coordinated to the final cropping.  

You can either crop the image yourself or use one of the 71 provided 

formats.  

 

 

 

Please note: If you choose the 

cropping, e.g. 13 x 18, the final 

image will not be saved as 13 

x 18 cm, rather as a ratio of 13 

to 18.  

 

 

 

 

As soon as the image has been cropped and captioned, confirm the 

save and the following window will prompt you to select a file format 

and name your file. 
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12. RAW-Processing  

You can upload and edit RAW image data with the integrated RAW 

mode. Numerous tools are available to you here, such as 

denoising/sharpen, exposure, colour, detail and powerful distortion 

capabilities.  

 

 
Interfering chromatic aberration can be easily removed in the 

“colour” category.  

 

An overview of the most important RAW functions:  

 

White balance: Here you can regulate the colour temperature. Use 

the pipette to select a white balancing colour directly from the 

image.  

 

Denoising/sharpness: This feature regulates the image’s noise and 

sharpness. Control the quality and different types of noise such as 

colour noise, banding or hot pixels.  
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Colour balance/white balance: Here it’s all about colour and 

black/white correction. Modify the general colour mood and 

neutralise white and black - the icing on the cake for professional 

colour correction. 

Exposure: Influence lights, shadows, contrast and brightness in the 

final image. With the new dynamic exposure you can adapt the 

brightness to the contents of the image. 

Detail: Fine-tune clarity and micro-details with lights, shadows and 

midtones.  

 

Colour: These colour settings are all about the luminosity of lights 

and shadows. You can even reduce the presence of unwanted 

chromatic aberrations.  

New is differentiating chromatic aberrations by colours:  

 

Green light diffraction  

Blue light diffraction  

Red light diffraction  

 

The light diffraction corrector removes chromatic aberrations of a 

certain colour. Thereby a lens curve will be calculated backwards on 

top of the colour channel. Dabei wird eine Objektivkrümmung 

rückwärts auf dem ausgewählten Farbkanal gerechnet.  

 

Palate:  

Adjust the saturation of individual colours.  
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Distortion: Take a closer 

look. These mighty tools 

can straighten out the 

horizon, correct camera 

angles and lens errors. Use 

“Autofit” to automatically 

trim any awkward borders. The reference grid can be adapted in the 

distance between the grids as well as in its transparency. This is how 

you will always have the maximum overview when you are 

correcting your settings.  

 

New: Category FX  

 

 
 

This category includes a several new special effects like a mist & fog 

correction, saving spotlights, sepia and film grains as well as 

different gradients.  
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Pro Tip  

When you take a landscape shot, shift the controller to “Gradient 

top” to a dark tone and create in that way a neutral thick (ND) – 

process filter.  

 

General:  

Activate the “360° panorama mode” to optimise matching edges of 

images in a panorama series. If you have conducted the settings in 

RAW mode, click on “apply”.  

Save your settings as a camera profile to save time in the future. This 

can be reset at any time. 

 

13. Batch processing 

 

COLOR projects 5’s batch 

processing allows for automatic 

processing of multiple 

bracketing series. The function 

can be found in the drop-down 

menu for “Extras” in the menu 

bar.  
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Note: Remember that looking through folders with several 

subfolders can require a lot of time. That’s why selecting “C:\“ is not 

recommended  

 

 Results: Here you can set where the resulting images of the 

batch processing will be saved. Select the corresponding 

folder with the “Target directory (. . .)” button or enter the 

name of the folder directly into the text box.  
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 Format: You can choose from five different formats to save 

your resulting images. In form of .jpg and .tif, there are two 

8 -bit formats and two 16-bit formats, as well as one png 

format. JPG images are always the highest quality and TIF 

files are saved uncompressed and without defects.  

 

 Editing settings: Choose which filters of the batch you 

would like to apply. From here you can also access image 

preparation and select presets to be administered to the 

image. If you would like to later assemble the edited images 

into a 360 Panorama, select panorama mode to eliminate 

exposure and contrast edges in the individual images. 

 

Tip: It is better to select a preset from the “natural” or “landscape” 

categories if you have a large number of images to process at once. 

Extreme effects are better suited to individual images.  
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14. Via GPS coordinates directly to 

OpenStreetMaps  

New: If the GPS coordinates are in your Exif-files (Menu -> Exif 

information), then you will be able to locate the place where the 

photo was shot when you click on the button “Open GPS coordinates 

via Browser”. You will see the place the photo was shot in 

www.OpenStreetMaps.org. 
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15. Add-ons 

With help from add-ons, you can not only import presets from 

COLOR projects 5, but also entire post-processing modules can be 

integrated, which can be necessary to create new preset looks. 

  

1. Extract the zipped files that you received with the download e.g. 

Prest-Collection-Color-projects-Seasons.zip 

 

2. Open your COLOR projects 5  

 

3. Click on Menu -> Add-ons -> Import Add-ons  

 

 
 

4. Select Photo projects Seasons (20) in the following dialog  

window, open it with a double-click and select the 

PHOTO_Seasons.praddon. Then click "Open".  

 

5. The add-on will now be imported. A confirmation message will 

appear:  

 

6. Please close and restart the program to be able to use the add-on 

with all of the other presets.  

 

7. Open COLOR projects 5 and load an image. Select Menu -> Add-

ons -> Add-ons Information, and confirm that your filter package was 

successfully activated.  
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Filter selection can be found on the left-hand side, directly under the 

import/export buttons.  

 

8. Here only the new, recently imported presets are displayed. 

 

 
 

9. Click the arrow to open the dropdown menu and select "Seasons". 

Now exclusively the new presets will appear on the left display box.  

 

10. If you would prefer to not filter the presets, the new presets can 

be found in the "Colour play" category.  
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16. Plug-In Installation 

 

COLOR projects 5 can also be used as a plug-in for Adobe® 

Photoshop. Newer versions of Photoshop are automatically detected 

by COLOR projects 5 during installation and the plug-ins are 

installed in the respective plug-in folder. Older versions of 

Photoshop might require manual installation.  

If you purchased your software as a download or if you have lost 

your CD, the plug-ins are also available for download at: 

www.projects-software.com/plugins 

 

 Installation of Adobe Photoshop & Adobe Photoshop 

Elements  

The following window will appear when installing COLOR projects 5:  
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Select the version of Photoshop where you would like to install the 

COLOR projects 5 plug-in. Click on “next” and follow the instructions 

from the installation assistant. The plug-ins will then be 

automatically installed.  

 

You can conduct the installation of the Plug-In at a later point as well. 

Please install Photoshop before the project Plug-ins!  

After the installation of the Plug-Ins, you can open Photoshop again.  

 

In Photoshop you will find under menu item “Filter” the entry 

Franzis. Here you will find all of the listed Plug-Ins.  
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Click on COLOR projects 5. The image that you have opened and 

edited in Photoshop will now be opened in COLOR projects 5.  

 

 
Now you will find the program in Photoshop Filter-Plugin mode. You 

will be able to edit the image as you´re used to in COLOR projects 

5. 

When you´re finished editing the image you can send the image 

directly back to Photoshop by clicking on the button “apply”.  

 

With the button “discard” you finish the filter Plug-in, without 

sending the changes that you have done to the image back to the 

Photoshop level.  

 

The editing that you have done in COLOR projects 5 will be 

discarded. The project program will then automatically close itself. 

This mechanism is conducted by Adobe Photoshop and cannot be 

stopped. 

 

 Using Plug-ins with Mac OS X  

 

Adobe Photoshop & Adobe Photoshop Elements  

 

Plug-ins can be found on the start screen in the “Plug-ins” folder. 

Select the appropriate folder for your version of Photoshop (we 

chose Photoshop CS6 for our example). Double click the .zip file to 

extract the plug-ins.  
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Next, drag & drop the plug-in COLORProjects5Filter_PH6.plugin 

(PH7 with other Photoshop versions) to the plug-in folder for your 

version of Photoshop, which is normally labelled as “plug-ins”.  

 

Start up your version of Photoshop, load an image and navigate to 

 

 
 

“Menu -> Filter -> Franzis-> COLOR projects 5“.  

 

 
 

With a click you start the Plug-In. The image will now be opened in 

COLOR projects 5.  

 

Now you will find the program in Photoshop Filter-Plugin mode. You 

will be able to edit the image as you´re used to in COLOR projects 

5.  
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When you´re finished editing the image you can send the image 

directly back to Photoshop by clicking on the button “apply”.  

 

With the button “discard” you finish the filter Plug-in, without 

sending the changes that you have done to the image back to the 

Photoshop level.  

 

The editing that you have done in COLOR projects 5 will be 

discarded.  

 

The project program will then automatically close itself. This 

mechanism is conducted by Adobe Photoshop and cannot be 

stopped. 
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 Adobe Lightroom Plug-ins with Windows  

 

 
 

Start the installation program and check in the component selection 

if “Lightroom Plugin” has been chosen. Copy the plug-in folder 

“Lightroom Plug-in” from your CD-ROM.  

 

If you have no CD, the plug-in is also available for download at: 

www.projects-software.com/plugins  

 

Subsequently open your Lightroom version. Start Lightroom and 

navigate to “File->Plug-In manager” to check if the plug-in has been 

activated.  
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LR: COLOR projects 5: Installed and executed  
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Mark a bracketing series in your lightroom library. Right-click on the 

image directly in Lightroom and select „Export -> Export to COLOR 

projects 5“.  

 

 
 

Or: Choose “File -> Export with Preset -> Export to COLOR 

projects 5“. 
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 Adobe Lightroom Plug-Ins with Mac OS X  

The Plug-In for Adobe Lightroom will not be automatically installed 

with MAC OS X. To integrate it into Lightroom, continue as follows:  
 

Install COLOR projects 5 to the program link of your Mac. 

Copy the plug-in .zip file from the “Lightroom Plug-in” folder on your 

CD-ROM. Double click on the .zip file to extract the plug-in to a folder 

where you want it to be located.  

 

We recommend the folder where also your presets are stored: 

  

“Benutzer(Users)/username/COLOR Projects 5“.  

 
 

Start Lightroom und navigate to “File ->Plug-In Manager“.  

 

Click the “Add” button in the Lightroom Plug-In Manager.  
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Choose the relevant Lightroom-Plug-In of COLOR projects 5 that 

you have just copied to your computer, by navigating towards it.  

 

If the Plug-in is not instantly marked with a green active dot, close 

Lightroom and start it again.  

Now the Plug-In should be installed and be up and running.  

 

You have now several options to get your image from Lightroom to 

COLOR projects 5.  

“File-> export with file-> export to COLOR projects 5”.  

OR:  

 

Right-click on the image directly in Lightroom and select „Export -> 

Export to COLOR projects 5“. 
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17. Keyboard shortcuts 
 

Overview of the integrated Keyboard shortcuts  
 

In the main menu in the area of information you will find an 

overview of all available keyboard shortcuts. Click on this item to 

open the overview.  
 

 
 

In the overview you will be able to scroll through the different areas, 

where you can take shortcuts.  

 
To have constant access to the overview via a separate window, you 

can use the function „open in browser“(window bottom left), which 

will show the list in a standard browser.  

You will also be able to print the keyboard shortcuts from there. 
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18. Integrated list of supporting camera RAW-

formats  

In the main menu in the area information you will find an 

integrated list of supporting camera RAW-formats sorted by 

manufacturer.  
 

 
If you chose this menu item a camera RAW-format window will open. 

 

  

In the top area of the window you will find a selection of choices, 

with which you will be able to filter the list for singular camera 

manufacturers. This way you will find your camera faster.  

To have constant access to the supporting camera RAW- formats via 

a separate window, you can use the function „open in 
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browser“(window bottom left), which will show the list in a standard 

browser.  

You will also be able to print the supporting RAW-formats from 

there. 

 

Photo credit:  

Imagery provided by the members of the FRANZIS projects team and 

the programmers.  

Special thanks to Mr. Falko Sieker for providing several exposure 

bracketing series and single images for testing purposes. The 

majority of the screen shots found in this user manual are results of 

Mr. Sieker's bracketing’s. 
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Support 

If you have questions regarding the installation, problems or errors of the 

software, please contact the FRANZIS customer support team. 

Contact form: https://www.projects-software.com/ 

Please understand that your questions can only be answered directly by 

FRANZIS customer support. This is to give us the opportunity to constantly 

enhance our customer service for you and to make sure that you receive only 

the most qualified answers to all of your questions as fast as possible. 

This is how our customer support works best: 

Please have the most important details about your computer and about our 

product at hand when you call our customer support. These include: 

• Name of the product 

• Product ISBN (which you can find on the back of the packaging, 

above the easy to spot barcode). 

• Operating system of your computer 

• Technical details of your PC including all your peripheral devices 

 

 

https://www.projects-software.com/
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Copyright 

Franzis Verlag GmbH has prepared this product with the greatest possible 

care. Please read the following conditions: 

All the programs, routines, controls, etc., contained in this data media or 

within this download are protected by their respective authors or distributors 

as mentioned in the respective programs. The purchaser of this data media 

or of this download is authorised to use those programs, data or data groups 

that are not marked as shareware or public domain for his/her own purposes 

within the provisions of their designated use. He/she is authorised to use 

programs or parts of programs that are marked as shareware, freeware or 

public domain within the restrictions given by the respective programs or 

parts of programs. A reproduction of programs with the intent of distributing 

data media containing programs is forbidden. Franzis Verlag GmbH holds the 

copyright for the selection, arrangement and disposition of the programs and 

data on these data media or these downloads. 

The data and the programs in this data media or within this download have 

been checked with the greatest possible care. Considering the large quantity 

of data and programs, Franzis assumes no warranty for the correctness of 

the data and a flawless functioning of the programs. Franzis Verlag GmbH 

and the respective distributors do not undertake neither warranty nor legal 

responsibility for the use of individual files and information with respect to 

their economic viability or their fault-free operation for a particular purpose. 

Additionally, there is no guarantee that all the included data, programs, icons, 

sounds and other files are free to use. Therefore the publisher cannot be 

held liable for a possible breach of third party copyrights or other rights. 

Most product designations of hard- and software and company names and 

labels mentioned in this product are registered trademarks and should be 

treated as such. The product designations used by the publisher are basically 

as the manufacturer describes them. 

© 2016 Franzis Verlag GmbH, Richard-Reitzner-Allee 2, 85540 Haar, München 


